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Version History  
09/2025 V1.1: 
This update has changes from 02/06/2025 up to August 22, 2025, release 1.1 with 
the following Major Highlights: 

Designers Editing Live Schedule: 
• Design Lead Contact(s) can request the Project Managers to provide edit 

access for the Live Schedule to the Design Lead Contacts 
• Project Managers will be able to grant Edit Access for the Live Schedule 

to the Design Lead Contacts 
• Design Lead Contacts are able to work directly on Live Schedule after 

getting the access 
• Project Managers are able to revoke the Edit Access for the Design Lead 

Contact(s) once the updates are done 
Document Management: 
• Document Tags for Combo Submissions 
• Common Selection of Document tags for Efficient Tagging while 

uploading documents 
• Other Document name Column & Filter 

 
Version  Date Modified  Notes  Modified By  
 V1.0 2/6/2025 Final Version Abhikant Sharma 
 V1.1 09/2025 Up to Release 1.1 Abhikant Sharma 
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1. Purpose of this Guide 
This User Guide provides guidance on how to request access, navigate and utilize the 
MassDOT Project Information Portal. 

2. Introduction 
MassDOT has launched a centralized portal that provides access to communities, including 
the design firms, federal agencies and state, and local agencies to communicate with the 
highway internal users. Currently, this portal is streamlined, specifically, for the design firms 
to communicate with the highway project management teams in real-time, in support of 
their respective business processes. However, the intent is to further streamline this portal 
to meet the specific needs of the other communities mentioned above. 
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Role(s) Responsibilities/Activities 

External Design 
Lead Contact  

● Reviewing My Work & Notifications 
o My Work Items via My Work screen 

● Accessing Projects 
● Searching Schedule 
● Selecting Design Schedule Template 
● Creating a copy of the Live Schedule on the Edit 

Schedule 
● Proposing Baseline Schedule under the Edit 

Schedule 
o Updating Completed Activities 
o Marking Activities/Activity Groups as Not 

Applicable 
o Adjusting Dependencies & Durations 

● Proposing updates on the Edit Schedule - 
o Marking Activity Groups/ Sub-Activities as 

Not Applicable or Applicable again 
o Adding Activity Groups 
o Adding Activities/Milestones 
o Updating Activity Durations 
o Editing Dependencies 

(Predecessor/Successor) 
o Adding a Resubmission 
o Reviewing Total Slack and Critical Path 

● Editing Live Schedule -  
o Requesting Access from the Project Manager 

for Live Schedule 
o Editing Live Schedule after receiving Live 

Schedule edit access 
● Logging Manual Update 
● Submitting Edit Schedule 
● Uploading Schedule Narrative documents 
● Viewing Schedule History 
● Uploading documents 
● Searching/Downloading documents 
● Exporting Schedule Search as a CSV  
● Communicating via Chatter 

Design Firm Admin 
(DFA) 

● Managing External Design Lead Contact’s Access 
o Accept 
o Deny 
o Deactivate 
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3. Getting Started with MassDOT Project Information Portal 
3.1. Requesting Access 
Note: External Design Lead Contacts should refer to the External Design Lead Contact(s) 
Section. 
 
For all other users: 
To request access to the MassDOT Project Information Portal, follow the steps outlined 
below. 
 
For users other than External Design Lead Contact(s): 
To request access to the MassDOT Project Information Portal, follow the steps below: 

1. Go to the MassDOT Project Information Portal login page.  
2. Click the Request MassDOT Portal Access link. 

 
3. Manually enter the required fields. (Do not use autofill) 
4. Click the Mass.gov Privacy Policy and Web Accessibility Statement links to review 

them and select the checkbox to acknowledge. 
5. Click Submit. 
Notes: 

● To cancel the request, the users can click the X icon or Cancel button. 
● In case of any questions or more information, users can contact the support team via 

projectinfosupport@dot.state.ma.us 
 

https://madothway.my.site.com/
mailto:projectinfosupport@dot.state.ma.us
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3.2 Logging In 
Prerequisite: User access to the Project Information Portal is approved, and a login 
password is set. 
 
To access the MassDOT Project Information Portal, follow the instructions below: 

1. Go to the MassDOT Project Information Portal login  page. 
2. Enter Username and Password and click Log in. 

 

3. Upon login, a Non-Disclosure Agreement pop-up will appear. Click OK to proceed. 

 

https://madothway.my.site.com/
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4.  The user will be directed to the Home page 

 

3.3 Forgotten Password 
In case of a forgotten password, or the need to reset the password, follow the steps below: 

1. Go to the MassDOT Project Information Portal login page 
2. Click Forgot your Password? 

 
3. This redirects the user to the Forgot Your Password page. 
4. Enter Username and click Continue. 

https://madothway.my.site.com/


 

PROJECT INFORMATION PORTAL USER GUIDE                                                                                       11 

 
5. An email with a Password Reset link will be sent to the user. 
6. Click the Password Reset link, which redirects to the Change Your Password page. 
7. Enter a New Password, re-enter it in the Confirm New Password field, and click 

Change Password. 

 

8. Users can log in to the MassDOT ProjectInfo Portal using the newly created 
password.  



 

PROJECT INFORMATION PORTAL USER GUIDE                                                                                       12 

4. External Design Lead Contact(s) 
For Release 1, the External Design Lead Contact(s) (from Design Firms or other Agencies) 
will be working in the Project Information Portal. 
 
For External Design Lead Contact(s) there are two roles: 

● Design Firm Admin (DFA) 
● External Design Lead Contact (EDLC) 

 

4.1. Design Firm Admin Role 
Prerequisites: Design Firm needs to identify at least one user who will be the Design Firm 
Admin (DFA). 
 
The Design Firm Admin (DFA) Approves/Denies the Access for the External Design lead 
Contacts for their firm to the MassDOT Project Information Portal. 
 
Once the Design Firm Admin (DFA) is identified for a Design Firm: 

1. The MassDOT System Admin is notified of the user who will be the Design Firm 
Admin (DFA) and will set them up: 

a. Design Firm Admin (DFA) will receive an email to set up their 
account/password 

b. They can login with username and password. 
2. On first login, Design Firm Admin (DFA) will check the box for Non-Disclosure 

Agreement (NDA) 
3. Design Firm Admin (DFA) will see an extra tab than other users named ‘Manage 

Users’ 
a. All future requests from the Design Firm will come here for the DFA to 

Approve or Deny. Refer to Design Firm Admin Reviewing the Request for 
more details. 

b. DFA can also Deactivate users from this location. Refer to  Design Firm Admin 
Deactivating the User for more details. 

Note: A Design Firm Admin can perform all roles that an External Design Lead Contact can. 
 

4.1.1 Design Firm Admin Reviewing the Request 
The Design Firm Admin (DFA) will receive an email notification containing a link to review 
the access requests for users in their Design Firm. This is to ensure that only authorized 
personnel from the Design Firm can access Project Information and manage tasks on the 
MassDOT Project Information portal. 
 
To review the request, follow the steps below: 
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1. Locate the notification email in the inbox and click the link to review the request 
details. 

 
2. Users will be redirected to the MassDOT ProjectInfo Portal Login page.  For more 

details on logging in, follow the steps outlined in the Logging In section. 
3. Once logged in, Review the Contact details e.g., Name, Email, Reason for Access etc. 
4. Click the Approve/Deny/Deactivate Portal User button. 

 
5. An Approve/Deny/Deactivate Portal User pop-up displays. 



 

PROJECT INFORMATION PORTAL USER GUIDE                                                                                       14 

6. If the details are valid, select "Approved" from the dropdown list and click the 
Submit button. Else, if the details are invalid, select "Decline" and click Submit.

 
7. This action will trigger an email notification to the External Design Lead Contact 

informing them of the decision. 
8. If Approved, the message ‘Portal user has been successfully created" displays, and 

two emails will be sent to the specified email address: a Welcome Email and a 
separate email containing Portal Access Instructions. 

 

9. Click the Close button. 
10. The Design Firm Admin (DFA) can see the Status updated under the  Access Status 

column.  
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4.1.2 Design Firm Admin Deactivating the User 

The Design Firm Admin has the authority to deactivate External Design Lead Contact(s) 
when they are no longer employed by their firm or associated with MassDOT. 

Prerequisite: To deactivate a user, the Access Status must be set to Approved. Follow the 
steps below: 

1. Log on to the MassDOT Project Information Portal 
2. Go to the Manage Users tab 
3. Click on the Name of the user to be deactivated 

 
4. Review the Contact details e.g., Name, Email, Reason for Access etc. 
5. Click Approve/Deny/Deactivate Portal User. 
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6. Select Deactivate from the Access Status dropdown. 
7. Click Submit.  

 
8. A message ‘Portal User has been deactivated’ displays.  
9. Click the Close button. 
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10. To view the list of deactivated users, enable the View Deactivated Users toggle. 

 
Note: This sends an email notification to the External Design Lead Contact informing them of 
deactivation on their mentioned email address: 

 
4.2. External Design Lead Contact Role 
The External Design Lead Contact is responsible for managing the Project Schedule and 
preparing/uploading Design Package Submissions.  
 
The External Design Lead Contact will navigate to the Portal Login Page via the Highway 
Website.  
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For the first time logging in, the External Design Lead Contact must request Access and 
follow the steps below: 

1. Click on the Request MassDOT Portal Access link 
2. Manually Enter the required fields. (Do not use autofill) 
3. Click on Account Type dropdown and select ‘Design Consultant’  
4. A Design Firm field displays. Type in the name of your Design Firm, your Design Firm 

will appear in the dropdown. Note: It is important to select the name of the Design 
Firm from the list and not manually type it. 

 
5. In the Email field, enter an Email with a domain provided by the Design Firm. 
6. Click the Submit button. Note: Mandatory fields with missing or incorrect entries will 

be highlighted in red. In such cases, re-enter the information manually (autofill 
should be avoided) and click Submit again.  

7. A success message ‘Your access request has been received’ displays. Click Close. 
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8. This generates an email and bell notification that is sent to the Design Firm Admin 

informing them that an External Design Lead Contact is requesting access. The 
External Design Lead Contact also receives an Email with information regarding 
Review and Approval Process. 

 
9. Once the Design Firm Admin (DFA) approves or denies the request, the External 

Design Lead Contact (EDLC) will receive an email notifying them of the decision. In 
the case of approval, the email will include instructions on how to set up their 
account. Refer to  External Design Lead Contact Account Setup for more details. 

 

4.2.1 External Design Lead Contact Account Setup 

Once the access request has been approved, the External Design Lead Contact must 
complete their account setup by creating a password. The user will receive an email from the 
MassDOT Project Information Portal confirming the approval of the access request. This 
email will contain a link to create the password. 

Note: Due to your firm security policies, emails from Salesforce may be directed to the spam 
folder if not found in the inbox. 

To set up the password, follow the steps below: 
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1. Locate the email in the inbox and click the Change Password link. 

 

 

2. Users will be directed to the Create Your Password page. 
3. Enter the New Password, then re-enter it in the Confirm New Password field. 
4. Click the Change Password button. 
5. Once the password is successfully set, the user will be automatically logged into the 

MassDOT Project Information Portal. 
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4.3. Home Tab 
The image below illustrates the layout available for the External Design Lead Contact and 
Design Firm Admin respectively.  
 
Upon login, the user is on the Home tab. This has three sections, My Work & Notifications 
and Chatter. 
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External Design Lead Consultant View: 

 
 
Design Firm Admin View (a Manage Users tab is also visible): 

 
 

4.3.1 My Work Items 
My Work Items section displays schedule activities assigned to the user that must be 
completed for projects with an Approved Baseline Schedule. 
 
To view Work Items, click on the down arrow against each Work Item.  
Note: Initially, no items are displayed in the My Work Items section. The My Work Items 
section serves as a starting checkpoint for the Users. 



 

PROJECT INFORMATION PORTAL USER GUIDE                                                                                       23 

 
Users can customize My Work Items view by selecting the required type from the Work by 
drop-down list.  
 
Refer to the brief description below to apply filters based on specific requirements: 

● Work by Due Date: Filtering Items based on period (as shown in this screenshot). 
Recommended Filter  

● Work by Project: Filtering items associated with Projects that are assigned to a user  
● My Priority Work: Filtering according to level of importance (Critical/High, 

Medium/Normal, Low, None)  
● Work by Type: Filtering by Item Type (Milestone, Activity, Card, Task)  

 
Users can use the Date feature to view work items in a specific date range.  
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Each work item includes a lightning icon that provides access to Quick Actions. Click the 
lightning icon to reveal the list of actions. For example, to open a specific Project, select the 
Navigate to Project option from the list.  

 
Users will be directed to the Project with which the activity is associated.  
 

4.3.2 Notifications 
The Notifications section provides a centralized list of all notifications received by the 
External Design Lead Contact. These notifications are triggered whenever there are updates 
related to a project, such as Design Submissions that are upcoming or overdue. On the Home 
page, scroll to the Notifications section to view the notifications. 
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Users can also view the notification alerts from the Bell Notification button.  
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4.3.3 Chatter 
External Design Lead Contact will receive Chatter from the Project Manager when assigned 
to a Project.  

1. Go to the Home Tab and Locate Chatter section on the right side of the page. 
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2. Scroll down and locate a Chatter posted by the Project Manager regarding Project 
assignment.  

 

3. Click on Comment. 

 

4. Enter a message in the text box, tag the desired user using (@), and click Comment. 
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5. The tagged User will receive a Bell Notification. 

Note: If there is no Chatter from the Project Manager mentioning about the 
assignment. Users can also initiate a Chatter by clicking on Share an Update and tag 
the Project Manager. 

If it’s a Project Specific conversation, post a Chatter tagging the Project Manager to 
initiate a Project Specific Chatter. And Reply as a Comment to that Chatter as 
described in the above steps. 

 
Important Note:  

Chatter entries are equivalent to MassDOT emails and text messages, intended for 
professional business use only, and are subject to discovery under the Freedom of 
Information Act (FOIA). 

 

4.4. Projects Tab 
The Projects tab in the MassDOT Project Information Portal provides a centralized view of all 
projects associated with the Design Firm. This tab is divided into two sections: 

● All Projects (My Firm): Shows all Projects linked to the Design Firm, providing a quick 
overview of general project information, even when User is not directly assigned. 

● My Projects: Displays projects User is directly assigned to, allowing full access to view 
project details and perform updates as needed. 
 

The Projects tab also enables users to track project statuses, manage tasks, and collaborate 
effectively within the portal. 
 

4.4.1 All Projects (My Firm) 
Under All Projects (My Firm), users can view only basic project information, including the 
Project Number, Description, Associate Project Manager's Email Address, and Key 
Milestone Dates. 
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The Design Firm Admin Users can also view the External Design Lead Contact(s) that are 
assigned on the Projects under their Design Firm. 

 
4.4.2 External Design Lead Contact Requesting Access to a Project 
External Design Lead Contact needs to request access to get direct access for a specific 
project listed under All Projects (My Firm): 

1. Go to the Projects > All Project (My Firm). 
2. Locate the Project and click on the Project Manager Email link. 

 
3. Enter required information in the Email body and click Send. 

Note: The email body will be auto populated based on the selected project. If it is 
not (e.g., due to an outdated version of Outlook or a non-compatible email client), 
manually enter the project details and send the email to the Project Manager for 
assignment. Alternatively, copy the Project Manager’s email and send the details 
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directly if Outlook or pop-ups are blocked.

 
4. When the Project Manager adds the External Design Lead Contact to the Project, a 

Chatter should be initiated on a Project, and the External Designer should respond 
to that chatter to associate the message with the Project. 

 

4.4.3 My Projects 
All Projects assigned to the User will be displayed under My Projects. 
To go to My Projects page, follow the steps below: 

1. On the Navigation Bar, click Projects. 
2. Click the My Projects sub-tab to view the list of assigned projects. 
3. Click on the required Project # hyperlink to go to the Project. 

Note: The screen may need to be refreshed to display the project after assignment 
if it was already open. 

 
 
The user is directed to the selected Project. 
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4.5. Selecting a Design Schedule Template to create a Baseline Schedule 
(Initial Project Design Schedule) 

Prerequisite: The Project Manager must have assigned the External Design Lead Contact for 
the project and sent a confirmation via Chatter. 

After assignment, the External Design Lead Contact can select a Design Schedule template to 
incorporate into the existing Initiation-PRC schedule on the Live Schedule.   

Note: In case, a Design Schedule Template has already been added to the project, follow the 
steps below: 

1. Go to the Project. 
2. Go to the Search Schedule. 
3. Click on Export as CSV to export the Live Schedule Activities. This will document the 

date(s) of completed or in-progress activities prior to assignment. Refer to the Export 
Project Activities as a Report section for more details. 

4. Contact the Project Manager using Chatter to request the deletion of the existing 
schedule template. 

5. Once the deletion is complete, a new Design Schedule Template can be added. 
 
To select and add a Design Schedule Template for a Project, follow the steps below: 

1. Go to the Project.  
2. Go to the Live Schedule. 
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3. By default, Users can see the Initiation-PRC Activity Group on the Live Schedule. 

 
4. Click Select Schedule Template under the Schedule Status Info section. 

 
A Select Schedule Template pop-up displays.  

5. Click on the radio button next to the desired Schedule Template and click the Next 
button. Note: In this example the Design Bid Build Template is selected. The steps 
that follow are the same regardless of the Selected Template. 
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6. A progress bar is displayed while the schedule template is loading. 

 
7. A success screen will appear once the progress bar completes. Wait for the schedule 

to finish loading. Click the Close button when the Gantt chart background changes 
from grey to white. 

 
 

8. Once complete, the selected template will appear on the Live Schedule. The message, 
“You only have Read-Only Access to the Live Schedule.” displays, indicating that 
proposed edits must be made in the Edit Schedule. 
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4.6. Adding Combo Submission 
Depending on Project scope and/or need to expedite, Project design may be streamlined by 
combining Design submission packages, referred to as a Combo Submission. 
 
Note: Combo Submissions are standard Activity Groups on many of the Design Schedule 
Templates like Resurfacing, Routine Maintenance & Site Specific Streamlined Bridge 
Preservation. If an additional Combo Submission is needed to be added, use the Add Combo 
Submission button. 
 
An Add Combo Submission is a combined submission of different project stages, such as 
25% and 75% design. When a combo submission is completed, the application automatically 
updates the Project Stage to the higher of the two stages. 
 
For example, if the Percent Complete for “Prepare and Submit 25%/75% Design Submission” is 
changed to 100% on the Live Schedule, the project stage will advance to the 75% design 
stage. This feature allows for the streamlined submission and progression of multiple design 
stages simultaneously. 
 
Activity Submission Project Progress 
Prepare and Submit 25%/75% Design Submission Project will move to 75% stage 
Prepare and Submit 75%/100% Design Submission Project will move to 100% Stage 
Prepare and Submit 100%/PS&E Submission Project will move to Final Stage 

 
To add a Combo Submission,  

1. Go to the Project  
2. Click on Live Schedule Tab 

 
3. Click Add Combo Submission  
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4. Once clicked, it displays the types of Combo Submission that can be added on the 

Live Schedule: 

 
 

5. Select Add 25%/75% Design Package option and click on Save. 
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6. Upon completion of the loading process, a green success message stating ‘Combo 
Submission added successfully’ is displayed. 

 
 
When a combo submission is completed, the application automatically adds the Combo 
Submission Template above the higher of the two stages. For example, if the Combo 
Submission for “25%/75% Design Submission” is added, it is automatically placed above the 
75% Design package on the Live Schedule. 

4.7. Edit Schedule for Baseline Creation 
Note: The Live Schedule is Read Only for the External Design Lead Contact(s). And thus, for 
proposing the Baseline Schedule Updates, the External Design Lead Contact(s) need to utilize 
the Edit Schedule. The Project Manager can make updates directly on the Live Schedule 
when needed. 

 
To create an original Baseline Schedule, the External Design Lead Contact must first make a 
copy of the Live Schedule and propose any necessary changes under the Edit Schedule tab. 
Prior to copying the Live Schedule for editing, any required additions of the combo 
submission should be made within the Live Schedule. 
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Note - The Live Schedule is Read Only for the External Design Lead Contact(s). And thus, for 
proposing the Baseline Schedule Updates, the External Design Lead Contact(s) need to utilize 
the Edit Schedule. The Project Manager can make updates directly on the Live Schedule 
when needed. 
 
To create an original Baseline Schedule, the External Design Lead Contact must first make a 
copy of the Live Schedule and propose any necessary changes under the Edit Schedule tab. 
Prior to copying the Live Schedule for editing, any required additions of the combo 
submission should be made within the Live Schedule. 

4.7.1 Copying a Live Schedule 
Note: Add the Combo Submission on the Live Schedule first, if required. Refer to the Add 
Combo Submission section for detailed instructions.  
 
To make a copy of the Live Schedule, follow the steps below: 

1. Go to the Project 
2. Go to the Edit Schedule. 

Note: If no schedule is currently being updated, an alert will be displayed on the page. 

 
3. Click Copy Live Schedule to Edit. 

 
4. A progress bar is displayed while the Copy of the Live Schedule under the Edit 

Schedule is being generated. 
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5. A success screen is displayed once the progress bar is complete. Close this screen and 

wait for the schedule loading to be completed. 
 

 
 
You would also see the following popup. Click Turn Off or Skip to close it. 
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6. Once this process is complete, the Copy of the Live Schedule appears under the Edit 
Schedule Tab. 

 
7. Also, Under the Schedule Status Info section, the Schedule Status field is updated 

with today’s date and the status, ‘Copy of Live Schedule added to Edit Schedule tab’. 

 
 

4.7.2 Viewing and Customizing the Edit Schedule  
The External Design Lead Contact can view the contents and customize the view of the Edit 
Schedule. 
 
The frequently used customizable features are described below: 
Refresh button: 
The Refresh button updates the schedule to display the most recent changes. It is used after 
editing activities in the schedule template to ensure the latest modifications are visible. 

 
 
Expanded View: 
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Select the four-arrow icon located in the top-right corner of the Edit Schedule to open it in a 
new tab with an expanded view. 

 
Note: In Expanded View, the Reload this page icon is at the top-left corner. Hovering over 
the icon will also indicate this. Click it to refresh the screen. 

 
 
Filter Activities/Milestones by Key Words: 
Users can filter and search for desired Activities or Milestones using keywords. 

1. Select the Search icon (  ). 
2. Enter the keyword in the field Filter By keyword. 
3. To close the filter and see the results, click the X icon. 

4. To reset the filter, click on the Search icon and then click the Reset icon ( ). To see 
updated results, click on the X icon. 
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Note: 

● Users can click the Save Filter button to retain their filter preferences. This enables 
them to view the same filtered results on the Schedule each time they return to the 
Project. 

● Users have the ability to utilize a range of predefined filter options available in the 
pop-up. For Example, Users can filter on Stickers for Activities by using the By Sticker 
option as shown below: 

 
● Users can also reset the filters after use, by clicking on the Reset Icon 
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Adding Columns: 

1. To add a column on the Schedule, click the + icon next to the Name column. 
2. Select Add New Column > desired column (For example, % Done) from the 

predefined dropdown list. 
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3. The selected column will be displayed on the Schedule. 

 
 
Removing Columns: 

1. To remove a column, hover over the column header until a downward arrow appears, 
then click on it. 

2. A Remove Column option appears. Clicking on this will remove the column. 

 
 
 
Adjusting column/Gantt chart size: 

1. Click between the column headers and drag (Left/Right) to adjust the size. 
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2. Similarly, click on the Gantt chart separation line and drag (Left/Right) to adjust the 
Gantt column size. 

 
 
Gear Icon: 

1. Click the down arrow next to the Gear icon to display the dropdown menu. 
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2. Users can utilize the following options in the dropdown menu to customize the 

Schedule view: 
● Collapse All will collapse all folders in the Schedule.. 
● Expand All will expand all folders in the Schedule. 
● Enabling the Show Activities 100% Done toggle button will display only those 

Activities that are 100% complete. 

4.7.3 Proposing Updates for Baseline Schedule 
 
Note:  To propose updates on the Edit Schedule, it is recommended to open the Edit 
Schedule in the Expanded View. Refer to Viewing and Customizing the Edit Schedule section 
for more details. 
 
MassDOT has made the business decision that Activity relationships in the Design Templates 
are Finish-to-Start (FS) with no Lags. These constraints must not be modified in in your 
Baseline submissions. To align submission dates, EDLCs should adjust activity durations or 
add a new Activity to the Schedule in lieu of a lag. 
 
Once a Copy of the Live Schedule is created under the Edit Schedule, the External Design 
Lead Contact can propose updates on the Edit Schedule for creating the Baseline Schedule.  
Users must refer to the most recent Microsoft Project Design Schedule (.mpp file). 
 
Note: The following updates are automatically saved in the Edit Schedule if a user logs out 
or is timed out: 

1. Activities Manually Scheduled 
2. Changed End Dates and Durations 
3. Activities marked as Not Applicable 
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4. New Activities/Activity Groups 
5. Dependency Changes [If a User believes the dependencies of an activity are incorrect, 

they should email Project Controls to verify them.] 
 

Important: Revised dates are not saved unless activity durations are updated or the 
Completed Activities are Manually Scheduled. Otherwise, dates will be driven by 
Schedule Logic. 

While creating the Baseline Schedule, follow the steps below: 
1. Update the Completion Date(s) for the activities that were completed prior to the 

ProjectInfo Baseline Submission and mark those Activities as “Manually Scheduled”. 
Include completed Activities where MassDOT is the Owner such as Reviews. 

2. Update the Future Dates by revising the Duration(s) of the Activities. 
3. Review and mark the Activities which are out of scope as Not Applicable (N/A). 
4. If a Combo Submission or a New Activity Group is added, or if Activities/Activity 

Groups are marked as Not Applicable, update the dependencies 
(Predecessors/Successors) as necessary to maintain the integrity of the Schedule 
Logic. 

5. Users can filter activities using the Major Milestone (M) sticker to display all major 
milestones. After reviewing the end dates of these milestones adjust the durations of 
activities under the milestone as needed. 
Note: Verify the Designer Readiness Date as needed and compare that to the Ad 
Date. Refer to the Reviewing Ad Date on the Edit Schedule Gantt Chart section for 
the steps to view Ad Date. 

 

4.7.3.1. Updating Completed Activities 
Prerequisite: The Copy of the Live Schedule under the Edit Schedule is created by the 
External Design Lead Contact. 

 
For all Activities that were completed prior to the ProjectInfo Baseline Submission, the 
Completion Date(s) must be corrected on the Edit Schedule. Additionally, these activities 
must be marked as ‘Manually Scheduled’. The External Design Lead Contact may refer to the 
most recent Microsoft Project Design Schedule (.mpp file) for the project to obtain 
information on completed activities.  
 
To update Completed Activities: 

1. Go to the Project. 
2. Go to Edit Schedule 
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3. Scroll down to the Edit Schedule and locate the Activity which is completed before 

the ProjectInfo Baseline Submission. Note: In this example the Activity Conduct & 
Submit Survey is used. The steps that follow are the same regardless of the Activity. 

 
4. Click on the vertical ellipses (three vertical dots) and click on Edit Information. 

 
5. Under Activity Info Tab, locate the Start Date and Due Date fields. 
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6. Click on the Calendar icon for the Start Date and adjust it accordingly to ensure that 
the Due Date reflects the correct Completion Date for the Activity.  Use the 
downward arrow to modify the Year, the side arrows to navigate between Months, 
and select the appropriate date as needed. 

 
7. After selecting the date, click on the Activity Mode Tab (or the  Milestone Mode Tab 

if updating a Milestone) and locate the Manually Scheduled checkbox. 



 

PROJECT INFORMATION PORTAL USER GUIDE                                                                                       50 

 
 

8. Select the Manually Scheduled checkbox and click Save. 

 
 

Note:  
○ Once an activity is designated as Manually Scheduled, its dates will remain 

unaffected by any schedule updates to other activities. 

4.7.3.2. Marking Activities/Activity Groups as Not Applicable 
Any activity or activity group that is out of scope for the project must be marked as Not 
Applicable (N/A). By default, all activities and milestones are considered Applicable in the 
Schedule unless explicitly marked as Not Applicable by the user. 
 
Impacts of Marking an Activity/Activity Group as Not Applicable: 
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1. Sets the Duration for the Activities to Zero (0) 
2. Removes the Predecessors/Successors for the activity 
3. Excludes the Activity from the Critical Path Logic 
4. Removes the Scheduling Gantt Chart Lines from the Activity Groups  
5. Adds a Not Applicable(N/A) sticker to the Activity/Activity Group 
6. The Activity/Activity Groups’ Start and End dates are changed to the PRC Approval 

Date automatically. 
7. If the percent completion of the activity was incorrectly set with the status as 100% 

done, the system will change the status to 0. 
8. Any pre-existing my Work Tasks are deleted for all the Activities marked Not 

Applicable. 
9. No further My Work Task Assignment and Notifications/Emails are sent out for any 

Activity marked as Not Applicable. 
 

Prerequisite: Since marking an Activity as Not Applicable (N/A) removes its 
Predecessors/Successors users must ensure the following within the Project Schedule: 

● The previous Predecessor activities have a Successor activity (other than the activity 
that is to be marked as Not Applicable)  

● The previous Successor activity has a Predecessor activity (other than the activity 
that is to be marked as Not Applicable)  

For detailed steps on updating dependencies, refer to the Editing Dependencies section. 
 
To mark an Activity Group/Activity as Not Applicable (N/A), follow the steps below: 

1. Go to the Project 
2. Go to Edit Schedule 
3. Under the Edit Schedule, locate the Activity Group/Activity that needs to be marked 

as Not Applicable. 
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4. Click on the vertical ellipses (three vertical dots), click on the downward arrow and 
click on Quick Actions. 

 
5. Click on Mark Not Applicable. 

 
6. Once the process is complete, click Finish on the Mark Activities Not Applicable 

popup. 
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When an Activity Group/Activity is marked as Not Applicable, A Not Applicable(N/A) Sticker  
is added to the Activities/Activity Group.  User may need to click refresh for the N/A sticker 
to appear on their Schedule. 
 
Note:  Mark Not Applicable Quick Action can be used for an Activity, or an Activity Group or 
even a Parent Activity Group: 
 

Parent Activity Group →  

 

Activity Group → 

Activity → 

 

4.7.3.3. Adding Activity Groups 
To add a New Activity Group on the Schedule, follow the steps below: 

1. Identify the existing Activity Group under which the new group will 
be added. 

2. Click the vertical ellipses (three vertical dots) 

 
3. Click on Quick Actions > Add New Activity Group 
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4. Enter a New Activity Group name and select Activities needed under 
the new Activity Group 

 
5.  Select the Activity Review Discipline based on the section for which the new 

Activity Group is being added. For example, if adding a New Environmental Permit, 
the appropriate Activity Review Discipline to select would be Environmental. 

 
6. Select a Stage Sticker which is applicable for the New Activity Group and click Next. 
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7. Once loading is complete, the new Activity Group will appear in the Edit Schedule. 

 
8. Update the Dependencies (Predecessors and Successors) if it is not a linear 

dependency. Refer to the Editing Dependencies section. 
9. To update more information, click the Vertical Ellipsis > Edit Information for the 

Activities under the New Activity Group. 
10. In the pop-up screen for the selected Activity displays. Locate the Activity Info and 

update the Assign an Owner, Start Date, and Due Date fields. 

 



 

PROJECT INFORMATION PORTAL USER GUIDE                                                                                       56 

Note: Assign the Project Manager as the Owner for new activities. The assigned 
Owner is responsible for actualizing the completed activity on the Live Schedule. 
 

11. Locate the Custom Fields update WBS Code and click Save. 

 
 
Note: The WBS Structure is intentionally developed to align with the Area of Work 
and the Division/Subdivision of Work as defined in the Scoping Workbook. Do not 
modify the WBS Structure under any circumstances. For questions regarding WBS 
codes for new Activity Groups, contact Project Controls via Chatter. 
 

Similarly, ensure the WBS Code for all the Activities/Milestones under the New Activity 
Group is updated. 

4.7.3.4 Adding a new Activity after an existing Activity (Activity, Milestones)  
Activities can be added above, below or within an existing Activity. Activity types are 
identified by the icons next to their names. The below image shows the various tasks 
on the Schedule. 
 
To add an activity, navigate to the desired Activity Group, click the vertical ellipsis > 
Add > and select the required option from the dropdown. 
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Options Action on selection 
Activity Above An Activity is added above the selected Activity Group 
Activity Below An Activity is added below the selected Activity Group 
Milestone A Milestone is added under the selected Activity Group 

 
12. The newly added Activity will be shown on the Schedule. Double-click the Activity 

to rename it. 
13. NOTE: If an Activity is added by mistake, the External Design Lead Contact will not 

be able to Delete Activities from the Edit Schedule. Change its name to “Error” and 
the Project Manager should delete that Activity directly from the Live Schedule. 

 

4.7.3.5 Editing Dependencies 
Prerequisite: Columns for Predecessors, Successors and Sequence are added on the Edit 
Schedule. Refer to Viewing and Customizing the Edit Schedule section to know more about 
adding a column. 

 
To update the dependencies (Predecessors/Successors), follow the steps below: 

1. Locate the Sequence value of the Activity that needs to be added as the 
Predecessor/Successor of the Activity and make a note of it.

 
2. Go to the Activity where the Predecessor/Successor needs to be added 
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3. Double-click under the Predecessor or Successor column such that it becomes 
editable 

 
 

4. Enter the identified sequence value and click anywhere on the schedule to save the 
changes. 
Note: If multiple Predecessor or Successor values are required, separate the 
sequence values with a semicolon (;) as shown below: 

 
After updating the Predecessor and Successor, the dates automatically adjust based 

on the new predecessors and successors. 
 

4.7.3.6 Reviewing Ad Date on the Edit Schedule Gantt Chart 
 
The Ad Date is displayed on the Edit Schedule Gantt Chart as a Red Dotted Vertical Line. 

• You can hover over the Ad Date Blue Box as well which would display the Ad Date for 
the Project as shown below -  

 

4.7.3.7 Reviewing Major Milestones and adjusting Durations as needed 
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Prerequisite: Column for Stickers is added on the Edit Schedule. Refer to Viewing and 
Customizing the Edit Schedule section for more details on Adding a column. 

 
All the Major Milestones on the Schedule have a sticker for Major Milestone (M) added to 
them. Users can review the Major Milestones on the Edit Schedule by filtering on the Major 
Milestone (M) sticker.  
 

 
 
Refer to Viewing and Customizing the Edit Schedule section for more details on Filtering out 
the Activities By Sticker on the Edit Schedule.To update Activity Durations follow the steps 
below: 

1. Identify the Activity requiring a Duration update and double-click on its Duration 
column value. Consult the MassDOT Highway Division Interoffice Memorandum for 
guidance on review duration changes. 

 
2. Manually update the Duration by entering the required number or using the 

up/down arrows. A red flag will indicate any changes in dates and durations resulting 
from these modifications.  

 
3. Click anywhere on the screen to Save. 
4. The Activity Duration Changes will be saved and the subsequent Date changes 

because of this Duration Change will be applied to the successor Activities and 
Milestones as well. 

 

4.7.4 Logging Manual Update 
Prerequisites:  

1. If working in the Expanded view of the Edit Schedule, close the Expanded View Tab 
on the browser and navigate to the Project under the Edit Schedule tab. 
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2. Click on the Refresh button under the Edit Schedule tab.  

Refer to Viewing and Customizing the Edit Schedule section for more details on 
Refresh. This step must be performed before Log Manual Update, regardless of 
whether the user was working in the Expanded View. 
 

Log Manual Update the Baseline Schedule before submitting to the Project Manager. 
To log it, follow the steps below: 

1. Go to the Project 
2. Go to Edit Schedule   
3. Scroll up and locate the highest level of Schedule Template, i.e., where Schedule 

Template name is visible. 

 
4. Click on the vertical ellipsis (three dots) and select Quick Actions

 
5. Click on the Log Manual Update quick action. A blank pop-up will briefly appear and 

then close automatically, as shown below. 
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6. Upon completion, wait for the Log Manual Update process to finish.  

Note: This process may take two to five minutes, depending on the number of 
proposed changes in the Edit Schedule 

7. Upon completion of the process, the Design Lead Contact will receive a notification 
stating, "Edit Schedule Ready for Submission to the Project Manager." 

 
Note: If the Baseline Schedule is submitted before the notification appears, 
the following screen will be displayed upon clicking Submit Baseline 
Schedule: 
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4.7.5 Submitting Baseline Schedule 
Prerequisite: The Design Lead Contact clicked on the Log Manual Update Quick action for 
the Baseline Schedule and received the notification stating, "Edit Schedule Ready for 
Submission to the Project Manager." 

Upon completing the Log Manual Update process for the Baseline Schedule, the External 
Design Lead Contact submits the Baseline Schedule for the Project Manager’s approval. 

To submit the Baseline Schedule: 
1. Go to the Project. 
2. Go to Edit Schedule 
3. Under the Edit Schedule > Schedule Status Info section, click Submit Baseline 

Schedule. 

 
 

4. A Green Success Message is displayed saying Baseline Schedule submitted 
successfully.  

 
3. The Schedule Status is updated to Today’s date - Baseline Schedule submitted for 

Review. The Project Manager is notified of the submission by a Bell Notification and 
an email.  
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4.7.5.1 Discrepancies Screen in the Edit Schedule 
Discrepancies in the Edit Schedule screen may be displayed while Submitting the Baseline 
Schedule, when there are some additional changes made on the Edit Schedule after the Log 
Manual Update is clicked. 
 
For example, if a Design Lead Contact logs updates and submits the Edit Schedule for 
approval, & the Discrepancies in the Edit Schedule arise, follow the below steps: 

1. Go to the Project. 
2. Go to the Edit Schedule. 
3. Under the Edit Schedule > Schedule Status Info section, click Submit Baseline 

Schedule. 

 
4. Click on Save. 

 
5. A green success message is displayed stating  ‘Discrepancies are being resolved. 

Resubmit the Baseline Schedule when ready’. 

 
In case of Monthly Schedule Update, the message states ‘Discrepancies are being 
resolved. Resubmit the Schedule when ready.’: 
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6. Wait for 2 to 3 Minutes then click the Submit Baseline Schedule button again. 
7. A green success message is displayed stating  ‘Baseline Schedule submitted 

successfully’.  

 
8. The Schedule Status is updated to Today’s date - Baseline Schedule submitted for 

Review. The Project Manager is notified of the submission by a Bell Notification and 
an email.  

 

4.7.6 Uploading the Schedule Narrative Document 
A narrative outlining major issues, concerns, and explanation of any impacts on the project 
should accompany the Proposed Schedule Updates in the form of a document or a Chatter 
post. 
 
The narrative can address: 

● All the Activities Completed before the ProjectInfo Baseline Submission, that have 
been Manually Scheduled 

● Status of each major deliverable 
● Issues and proposed solutions 
● Significant Meetings and Events 
● Outstanding issues and critical actions required by the Designer, MassDOT or third 

parties. 
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Special attention should be given to any actions or issues that may impact Project 
Milestones. Any significant changes to the schedule, including those resulting from scope 
modifications or project development adjustments, must be clearly identified. 

This document ensures that the Project Manager understands the rationale behind the 
adjustments and can plan accordingly. 

To upload a Schedule Narrative, follow the steps below: 
1. Go to the Project 
2. Go to Edit Schedule 
3. Click the View/Upload Schedule Narrative  

 
4. The user is directed to a View/Upload Schedule Narrative section. 
5. Click the Upload Schedule Narrative button. 

 
An Upload Schedule Narrative pop-up displays. 

6. Click the Upload Files button or drop files to upload the required document(s). 
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7. Click Done 

 
8. Click Save. 

 
9. The uploaded document(s) are listed under the Schedule Narrative(s) section below 

the Document Name column. Once the proposed edits are accepted by the Project 
Manager, the accepted date will appear under the Accepted Schedule Date column. 
To view the document contents, the User has to select the check box(s) next to the 
document name and click the Download Schedule Narrative button. This will save a 
copy of the file(s) to the local drive. 

10. Click Close to exit the current view. To view the Schedule Narrative again, click the 
View/Upload Schedule Narrative button. 
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Note: Instead of uploading a Schedule Narrative, the External Design Lead Contact can also 
update the Project Manager using Chatter located on the Home Tab. Refer to the Chatter 
section for more details. 

4.8 Baseline Schedule Accepted or Sent Back for Revision 

4.8.1 Baseline Schedule Accepted 
If the proposed Baseline Schedule is satisfactory, the Project Manager accepts the Baseline 
Schedule. The Design Lead Contact receives a Bell Notification and an Email notifying them 
of the Acceptance saying Baseline Schedule Accepted. 

 
 

Once the Baseline Schedule is accepted, the application initiates the process of merging the 
proposed Baseline Schedule updates with the Live Schedule.Upon completion of the 
merging process, the Design Lead Contact will receive a Bell Notification stating, "Schedule 
Updates Merged with Live Schedule." 
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Upon receiving the notification, the External Design Lead Contact should navigate to the 
Live Schedule to verify that the Baseline Schedule Updates have been accurately merged 
under the Live Schedule tab. 

 

4.8.2 Baseline Schedule Sent Back for Revision 
If the proposed Baseline Schedule is unsatisfactory, the Project Manager can send the 
Baseline Schedule back to Revise and Resubmit the Proposed Edits. 
 
The Design Lead Contact receives a Bell Notification and an Email saying Revise & Resubmit 
Design Schedule. 
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The Design Lead Contact can view the Schedule Review Comments provided by the Project 
Manager following the steps below: 

1. Go to the Project. 
2. Go to  Edit Schedule 
3. Go to the Schedule Status Info section and locate the Schedule Review Comment(s) 

field.  

 
4. The Design Lead Contact can collaborate with the Project Manager using Chatter as 

well if needed. Refer to the Chatter section for more details on using Chatter. 
5. The Design Lead Contact can update the Edit Schedule submitted based on the 

Schedule Review Comments received from the Project Manager. Do not make 
another copy of the Live Schedule. After making the necessary updates, they can Log 
Manual Update and resubmit the Baseline Schedule to the Project Manager. Refer to 
sections Logging Manual Update and Submitting Baseline Schedule for more details. 

4.9 Search Schedule 
The Schedule Search page gives users the option to run a basic Schedule Search or use the 
Advanced Search option and export the project activities on the schedule as a report. 



 

PROJECT INFORMATION PORTAL USER GUIDE                                                                                       70 

Go to the Project > Search Schedule. 

 

4.9.1 Basic Schedule Search 
To search for an activity on the schedule using an Activity Name:  

1. Enter the Activity Name in the Search for an Activity Name field and click the Search 
button. 

 
 
Search results will be displayed under the Projects Activities section.  

2. Click the Activity Name or Activity Group to go to the Activity. The Projects Activities 
table has several Display Columns such as Activity Group, Start, End, Duration, 
Predecessor, Successor, % complete, etc. Use the + Select More Fields to Display 
button to customize the columns that users want to see. 
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Note: Users have the option to export multiple Project Activities related information as a 
CSV file and Report. Refer to Export Project Activities as a Report section. 
 

4.9.2 Advanced Search Panel 
Within the Schedule Search, users have access to the Advanced Search panel, which allows 
them to filter and target their search results. 
Users can enter information in various fields to narrow their search. 
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Some of the examples are: 
● Users can select one or more Parent Activity Groups from the dropdown options. 

  
● Users can enter the desired Activity Name in the Activity Name field. 

 
To adjust the Advanced Search fields, users can proceed by clicking the Edit Search Fields 
button on the left panel. 
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4.9.3 Export Project Activities as a Report 
To export all the project activities on a Schedule as a report, follow the instructions below: 

1. Go to the Project > Search Schedule. 
2. Click the Export as CSV button. 

 
3. A Select Fields to Export pop-up displays. 

Select the fields to display in exported CSV and click the Export button. 
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4. A CSV file will be downloaded onto your local drive. Insert a row to add the project 

number and location, then rename the file before saving. 

 

4.10 Making Schedule Updates to the Live Schedule 
External Design Lead Contacts can request the Project Manager to give them the edit access 
to the Live Schedule for making schedule updates. 
To request the Project Manager to give Edit Access to the Live Schedule, send a Chatter or 
Email to the Project Manager asking them to provide the Edit Access to the Live Schedule. 
Please refer to Chatter section for the steps to send a chatter. 



 

PROJECT INFORMATION PORTAL USER GUIDE                                                                                       75 

Once the Edit Access for the Live Schedule is given to the User by the Project Manager, the 
following notification is received -  

 
 
Once received, navigate to the Live Schedule for the project for which the edit access is 
granted to you. 
 
The other method to propose schedule updates is by creating a copy of the Live Schedule 
under the Edit Schedule Tab, similar to the steps for creating a Baseline schedule.  
For further details on how to create a copy under the Edit Schedule, consult the Copying a 
Live Schedule section. 
After creating a copy of the Live Schedule, add a snapshot under the Edit Schedule before 
making schedule updates. A Snapshot should be added on the Edit Schedule to check the 
Total Slack and Delta between the End Dates, for comparing two versions of the Edit 
Schedule.  Refer to the Reviewing Total Slack section for more details. 
 

4.10.1 Proposing Updates on the Edit Schedule 
Prerequisite: Before proposing Schedule updates, the Baseline should be approved by the 
Project Manager. 
 
Note: The following updates are automatically saved in the Edit Schedule if a user logs out 
or is timed out: 

1. Activities Manually Scheduled 
2. Changed End Dates and Durations 
3. Activities marked as Not Applicable 
4. New Activities/Activity Groups 
5. Dependency Changes [If a User believes the dependencies of an activity are incorrect, 

they should email Project Controls to verify them.] 
Important: Revised dates are not saved unless activity durations are updated or the 
Completed Activities are Manually Scheduled. Otherwise, dates will be driven by 
Schedule Logic 

 
Users should avoid making the following changes on the Schedule:  

● Modifying the Template logic or dependencies incorporated (predecessors/successors) 
Note: If a User believes the dependencies of an activity are incorrect, they should 
email Project Controls to verify them. 
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● Modifying the WBS code Structure. 
● Modifying FS relationships &/or adding lags. 

Note: Attempting to edit any Activity if the percent is set to 100% will result in an admin 
error message as shown below: 

 
The External Design Lead Contact can make updates to existing Activity Groups, Activities, 
and Milestones, or add new Activity Groups, Activities, or Milestones to the Edit Schedule. 
 

4.10.2 Adding a Snapshot 
A Snapshot should be added on the Edit Schedule to check the Total Slack and Delta 
between the End Dates, for comparing two versions of the Edit Schedule. 
 
To add a Snapshot, follow the steps below: 

1. Go to the Project. 
2. Go to Schedule > Edit Schedule. 
3. Click on the Baseline dropdown and select the Save Schedule History option.  

 
4. Enter a Snapshot Title and click Add. 

 
Note: When a new Snapshot is created, Schedule Update Start Date and Schedule 
Update End Date are added as the first two columns on the Edit Schedule. To hide 
those columns, Click on the Baseline dropdown and select Hide Baseline option. 
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4.10.3  Marking Activities/Activity Groups as Applicable/Not Applicable 
Any activity or activity group that is out of scope for the project can be marked as Not 
Applicable. For further details, refer to the Marking Activities/Activity Groups as Not 
Applicable section. 
 
If an Activity/Activity Group needs to be marked as Applicable again, Users can utilize  the 
Mark Applicable quick action under the Edit Schedule.   
To mark an Activity, Activity Group, Sub-Activity, or Milestone as Applicable: 

1.  Navigate to the required Activity/Activity Group on the Edit Schedule. 
2. Click the vertical ellipsis(three dots) > Quick Actions, and select the Mark Applicable 

Quick Action. 

 

Note: When an Activity/Activity Group is marked as Applicable again, the Not Applicable 
sticker is removed. However, the Activity Duration and Dependencies 
(Predecessors/Successors) must be updated manually. 

4.10.4  Adding Activity Groups 
To add a New Activity Group on the Schedule, follow the steps below: 
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1. Locate an existing Activity Group below which the new Activity Group needs to be 
added. 

2. Click on the vertical ellipses (three vertical dots) 

 
3. Click on Quick Actions > Add New Activity Group 

 
4. Enter a New Activity Group name and select Activities needed under the new Activity 

Group 
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5. Select the Activity Review Discipline based on the section for which the new Activity 
Group is being added. For example, if adding a New Environmental Permit, the 
appropriate Activity Review Discipline to select would be Environmental. 

 
6. Select a Stage Sticker which is applicable for the New Activity Group and click Next. 

 
7. Once loading is complete, the new Activity Group will be displayed in the Edit 

Schedule. 

 
8. Update the Dependencies (Predecessors and Successors) if it is not a linear 

dependency. Refer to the Editing Dependencies section. 
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9. To update more information, click the Vertical Ellipsis > Edit Information for the 
Activities under the New Activity Group. 

10. A pop-up for the selected Activity displays. Locate the Activity Info and update the 
Assign an Owner, Start Date, and Due Date fields. 

 
Note: Users should assign the Project Manager as the Owners for new activities. 
Users who are assigned as the owners are responsible for actualizing the completed 
activity on the Live Schedule. 

11. Locate the Custom Fields and update WBS Code and then click Save. 

 
 

Note: The WBS Structure has been carefully developed to reflect the Area of Work 
and the Division/Subdivision of Work as defined in the Scoping Workbook. The WBS 
Structure should not be modified under any circumstances. Reach out to Project 
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Controls using Chatter if any questions regarding WBS Codes for New Activity 
Groups. 

12. Similarly, update the WBS Code for all the Activities/Milestones under the New 
Activity Group. 

4.10.5 Adding a new Activity under Activity Group (Activity, Milestones, Sub Activity, and 
Sub Activity Group)  

Various activities can be added under, above, and below an Activity Group. The below image 
shows the various tasks on the Schedule. The type can be differentiated by the icon next to 
the Name. 

 
1. To add, go to the required Activity Group and click the vertical ellipsis > Add > then 

click on the required option from the dropdown. 

 
 

Options Action on selection 
Activity Above An Activity is added above the selected Activity Group 
Activity Below An Activity is added below the selected Activity Group 
Subactivity A Sub-Activity is added under the selected Activity Group 
Subactivity Group A Sub-Activity Group is added under the selected Activity Group 
Milestone A Milestone is added under the selected Activity Group 
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2. The newly added Activity will be shown on the Schedule. Double-click the Activity to 
rename it. 

4.10.6 Updating Activity Durations 
Under the Edit Schedule, the Design Lead Contact can propose Duration changes for the 
Activities. Refer to the Updating Activity Durations section for more details. 

4.10.7 Editing Dependencies 
The Design Lead Contact can propose Dependency (Predecessors/Successors) changes 
under the Edit Schedule. Refer to the Editing Dependencies section for more details. 

4.10.8 Adding Resubmission Activity Group 
Resubmissions are primarily applicable to Design Packages but may not be relevant to all 
Activity Groups. 
 
For example, to add 25% Design Package as a Resubmission Activity Group, follow the steps 
below: 

1. Go to the Project. 
2. Go to the Edit Schedule. 

 
3. Locate the 25% Design Package Activity Group. 
4. On the Activity Group, click the vertical ellipsis (three dots) and select Add 

resubmission Quick action. 
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5. Click on Add 

 
6. Click on Close 

 
7. The Resubmission Activity Group is added below the original Activity Group. 

 



 

PROJECT INFORMATION PORTAL USER GUIDE                                                                                       84 

 
 
 

4.10.9 Reviewing Total Slack and Critical Path 
To review the Critical Path &/or Total Slack for Activities on the Edit Schedule, the Design 
Lead Contact must create a Snapshot under the Edit Schedule. Creating a Snapshot updates 
the Total Slack and Critical Path, ensuring the most current values are reflected. 

4.10.9.1 Adding a Snapshot 
To add a Snapshot, follow the steps below: 

5. Go to the Project. 
6. Go to Schedule > Edit Schedule. 
7. Click on the Baseline dropdown and select the Save Schedule History option.  

 
8. Enter a Snapshot Title and click Add. 

 
Note: When a new Snapshot is created, Schedule Update Start Date and Schedule 
Update End Date are added as the first two columns on the Edit Schedule. To hide 
those columns, Click on the Baseline dropdown and select Hide Baseline option. 
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4.10.9.2 Reviewing Total Slack 
Total Slack determines the number of days a Schedule Activity can be delayed without 
impacting the Schedule End Date (i.e. the Construction Contract NTP Date). 
To review the Total Slack of Activities on the Edit Schedule, follow the steps below: 

1. Click on the + icon near Name on the top left of the Edit Schedule and select the Add 
New Column option. 

 



 

PROJECT INFORMATION PORTAL USER GUIDE                                                                                       86 

2. Click on Custom Fieldset and select Slack

 
3. A column for Total Slack (In Days) is added on the Edit Schedule which displays the 

Total Slack of the Activities. 

 
4. Along with Total Slack, the Design Lead Contact can also check the Delta (In Days) for 

all the Activities. Delta shows the change in Slack for the Activities because of the 
schedule updates proposed, in comparison to the Baseline Schedule.  
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4.10.9.1 Reviewing Critical Path 
Critical Path on a Schedule displays the Activities with their Total Slack as less than or equal 
to 10 days.  A Critical Path (CP) sticker is added on the schedule activities, filtering on which 
Critical Path can be viewed. 
When reviewing the schedule logic, special attention should be paid to the Critical Path. The 
Critical Path is the longest sequence of Activities in the Project. Delays to Activities on this 
path will delay the Project completion. Users must ensure that the Critical Path along with 
the sequence of activities in it, align with the intended approach of the Project 
implementation. 
 
To review the Activities on the Critical Path on the Edit Schedule: 

1. Click on the + icon next to Name on the top left corner and select the Add New 
Column option 

2. Select Stickers 

 
 

3. Click the Refresh Button.  
Note: The schedule requires a Refresh to display the added Stickers. Therefore, 
reviewing the Critical Path, ensure to click on the Refresh button.  
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4. The Activities which are on the Critical Path will display a Critical Path (CP) sticker 

under the Stickers column.

 
 

5. The Schedule Activities can also be filtered by applying a filter to the Critical Path 
sticker. Refer to the Viewing and Customizing the Edit Schedule section for more 
details. 

4.10.9.2 Reviewing End Date Delta 
Note: Add a Snapshot on the Edit Schedule for reviewing the End Date Delta 
 
End Date Delta is the difference between the End Dates of the Schedule Activities 
between the first snapshot and the latest snapshot taken on the Edit Schedule. 
End Date Delta = (End Date of the Activity in the First Snapshot taken after creating a 
Copy) - (End Date of the Activity in the Latest Snapshot). 
 
To review the End Date Delta of Activities on the Edit Schedule, follow the steps 
below: 

1) Click on the + icon near Name on the top left of the Edit Schedule and select the Add New 
Column option. 
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2) Click on Custom Fieldset and select End Date 

 
3) A column for End Date Delta is added on the Edit Schedule which displays the Delta 
between the End Dates 
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4.10.9.3 Reviewing Ad Date on the Edit Schedule Gantt Chart 
Please refer to the Reviewing Ad Date on the Edit Schedule Gantt Chart section for 
the steps to view the Ad Date for a Project under the Edit Schedule. 

4.10.10 Viewing Schedule History 
The Schedule History provides a snapshot of the Baseline Schedule and/or a snapshot of 
subsequent updated Schedules. To view the Schedule History, follow the steps below: 

1. Go to the Project. 
2. Go to the Edit Schedule. 

 
3. On the Edit Schedule, click the down arrow next to Baseline and select the Schedule 

History option. 

 
 

4. A Schedule History pop-up will be displayed. 

 

https://massgov.sharepoint.com/:w:/r/sites/DOT-TEAMS-IT-PINFOModernizationProject/Shared%20Documents/UI%20UX/User%20Guides/Project%20Information%20Portal%20User%20Guide_V%201.0.docx?d=w6c26a232d9914b7ea8f2db5c682df6fb&csf=1&web=1&e=8cmzXB&nav=eyJoIjoiMTYzMzA5NzE2MiJ9
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When the user clicks on the Schedule History snapshot, columns for the schedule's Start 
Date and End Date will be added. This allows the user to compare the data and manually 
reconstruct or update the schedule as needed. 
 

 

4.10.11 Logging Manual Updates 
Prerequisites:  

1. If working in the Expanded view of the Edit Schedule, close the Expanded View Tab 
on the browser and navigate to the Project under the Edit Schedule tab. 

 
2. Click on the Refresh button under the Edit Schedule tab.  

Refer to Viewing and Customizing the Edit Schedule section for more details on 
Refresh. This step must  be performed before Log Manual Update, regardless of 
whether the user was working in the Expanded View. 
 

If the user proposes updates to an Activity/Activity Group manually, the update must be 
Logged as a Manual Update under the Edit Schedule. 
 
To Log Manual Update an Activity/Activity Group, follow the steps below: 

1. Go to the Project 
2. Go to Edit Schedule 
3. For the Activity Group/Activity updated, click the vertical ellipsis (three vertical dots) 
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4. Click on Quick Actions and Select Log Manual Update. 

 
5. A blank pop-up will briefly appear and then close automatically, as shown below. 

 
After logging a manual update, a Manual Update (MU) sticker will be automatically added to 
the selected Activity Group/Activity. 

6. Click Refresh.  
Note: The schedule requires a Refresh to display the added Stickers. Therefore, 
when reviewing the Manual Update Sticker, ensure to click on the Refresh button.  
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7. To view the Manual Update stickers on the Edit Schedule, Click the + icon at the top 

left of the Edit Schedule. 
8. Select Add New Column > Stickers from the dropdown. 

 
A Stickers column will be added to the Schedule displaying the Manual Update(MU) stickers 
that have been applied to Activities and the Activity Group that are Logged Manual updates. 
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4.10.12 Submitting Schedule Update 
Once the proposed updates are completed and are Logged Manual Updates on the Edit 
Schedule tab, the External Design Lead Contact can submit the proposed changes for the 
Project Manager’s approval. 
 
To submit the proposed changes: 

1. Go to the Project 
2. Go to Edit Schedule 
3. Under the Schedule Status Info section, click Submit Schedule Update. 

 
 

4. The Schedule Status will be updated to Today's Date - Schedule Submitted for 
review. The associated Project Manager is notified with a Bell Notification and an 
email. 

 

4.10.13 Discrepancies Screen in the Edit Schedule 
 
For Example: When the Duration is changed for an Activity, it might impact the Start/End 
Date(s) of its successor(s), which was already Logged as a Manual update earlier.  
Refer to the Discrepancies Screen in the Edit Schedule Section for more details. 

4.10.14 Uploading the Schedule Narrative Document 
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A narrative addressing major issues and concerns as well as an explanation of any impacts to 
the Project should be submitted with the Proposed Schedule update via a document or a 
Chatter post. Refer to the Uploading the Schedule Narrative Document section for more 
details. 

4.11 Schedule Update Accepted or Sent Back for Revision 
4.11.1 Schedule Update Accepted 
If the proposed Schedule Update(s) are satisfactory, the Project Manager accepts the 
Schedule Update(s). The Design Lead Contact receives a Bell Notification and an Email 
notifying them of the Acceptance saying Schedule Update Accepted. 

 

Once the Schedule Update(s) are accepted, the application initiates the process of merging 
the proposed Schedule Update(s) with the Live Schedule. Upon completion of the merging 
process, the Design Lead Contact will receive a Bell Notification stating, "Schedule Updates 
Merged with Live Schedule." 
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Upon receiving the notification, the Design Lead Contact should navigate to the Live 
Schedule to verify that the Schedule Update(s) have been accurately merged under the Live 
Schedule tab. 

 
4.11.2 Schedule Update Sent Back for Revision 
If the proposed Schedule Update(s) are unsatisfactory, the Project Manager can send the 
Schedule Update(s) back to Revise and Resubmit the Proposed Edits. 
The Design Lead Contact receives a Bell Notification and an Email saying Revise & Resubmit 
Design Schedule. 

 
The Design Lead Contact can view the Schedule Review Comments provided by the Project 
Manager following the steps below: 

1. Go to the Project. 
2. Go to the Edit Schedule 
3. Go to the Schedule Status Info section and locate the Schedule Review Comment(s) 

field.  
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4. The Design Lead Contact can collaborate with the Project Manager using Chatter as 

well if needed. Refer to the Chatter section for more details on using Chatter. 
5. The Design Lead Contact can update the Edit Schedule based on the Schedule 

Review Comments received from the Project Manager. After making the necessary 
updates, they can Log Manual Update and resubmit the Schedule Update to the 
Project Manager. Refer to sections Logging Manual Update and Submitting Schedule 
Update for more details. 

4.12 Documents 
The Documents tab is a central repository for all project-related documentation. 
In ProjectInfo, Documents are stored in a shared repository, in which the documents exist in 
a Flat Folder structure which are searchable using Document Tags/Metadata.  
Notes: 

● Designers do not have access to Legacy Documents. (Legacy Documents are the 
project files that were previously uploaded from MassDOT’s file repository) 

● The documents displayed under the Documents are approved by the Project 
Manager. 

4.12.1 Document Search 
Users can search for documents using a basic search and Advanced Search features. 

4.12.1.1 Basic Document Search 
To search for a document with a Document Name:  

1. Go to the Project > Documents tab. 
2. Enter the Document Name in the Search for Document field and click the Search 

button. 
Search results will display under the Uploaded Document(s) section. 
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3. The Uploaded Document(s) section has default columns Document Name, 

Document Tag, Version, Document Category, Milestone, Area of Work, and Activity 
Group. 
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4. Use the + Select More Fields to Display button to customize the columns. 

 
A Select More Fields to Display pop-up displays. 

5. Select the columns to display in the table and click the Save button. 

 
The user has the option to export the view of the results as a CSV file. Click Export as CSV to 
generate as needed.  

4.12.1.2 Advanced Search Panel 
Under the Documents tab users have access to the Advanced Search panel, allowing filter 
and target search results. 
Users can enter information in various fields to narrow their search. 
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Steps performed on the Documents > Advanced Search Panel are similar to the steps 
mentioned in Schedule Search > Advanced Search section. 

 

 
 
Export Documents as a Report 
The user has the option to export the view of the results as a CSV file. Click Export as CSV 
button to generate as needed.  
To export the documents as a report, follow the instructions below: 

1. Select the checkbox against the required documents. 
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1. Click the Export as CSV button. 

 
A Select Fields to Export pop-up displays. 

2. Select the fields to display in exported CSV and click the Export button. 
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3. A CSV file will be downloaded onto your local drive. 
• Note: Users can change format and alignment in the exported CSV. For example, you 

can set top alignment by using right-click on the selected cells, choose "Format 
Cells," navigate to the "Alignment" tab, and set "Vertical" to "Top" in Excel to see all 
the dependencies. 

 

 
 

4.12.2 Uploading Documents 
Users can upload documents for various Activity groups and tag users via chatter to notify 
them. 
Note: For any errors in document tag selection or upload of document(s), please consult the 
Project Manager. 
 
To upload a Pre-25% Design Package, follow the instructions below: 

1. Go to the Project > Documents. 
2. To upload the document, click the Upload button. 
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3. Under the Activity Group, click the Select an Activity Group down arrow, select the 

Pre-25% Design option, and click the Next button. 

 
4. Under Document Validation Checklist select the required answers and click the 

Next button. 
5. Note: You can click the Back button to go to the previous page. 
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6. After clicking next the user advances to the Upload & Add Details chevron. Locate 
and click the Upload button. 
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An Upload Document(s) pop-up displays. 

7.  Upload Document(s) window opens up with a list of Applicable Document(s) for 
Selected Activity Group. Click on the Upload Files button or use Or drop files.  
Note: Users can upload multiple files. 

 
8. A File Explorer pop-up displays. Select the required document(s) and click the Open 

button. 
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9. Once the document(s) are uploaded, click the Done button. 

 
10. After uploading the required files, click Next. 

 
 

11. An Uploaded Documents section displays with the uploaded documents. For each 
Document, update the required details (Document Tag, Milestone and Document 
Category). 
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12. Click the down arrow in the Document Tag column and select the required option 

(For example, Pre-25% OTS Conceptual Design Package) from the dropdown. 
(1) If your Document Tag is not available, Select “Other” as the Document Tag 

(a) A field will be displayed Other Document 
(b) Enter the Name of the document in the Other Document field. 

(c)  
13. Click the down arrow in the Milestone column and select the required option (For 

example, Pre-25%) from the dropdown. 
Note: The Milestone column will be auto populated based on the selected Activity 
Group but can still be edited manually. 

14. Click the down arrow in the Document Category column and select the required 
option from the dropdown. 

15. After performing the same action for each uploaded document, click the Save 
button. 
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The Uploaded documents will be displayed under the Documents tab. 

 
A Bell Notification is sent out to the Project Manager once the documents are successfully 
uploaded. 

4.12.3 Previewing Documents 
Users can see a preview of the documents from the Documents Tab by clicking on the 
Document Name Hyperlink. 

 
The Document Name hyperlink when clicked opens the preview of the document in a new 
tab. 
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4.12.4 Downloading Documents 
 
Users can download the documents from the Documents tab. 
To view and download the 25% Design Package document, follow the instructions below: 

1. Go to the Project > Documents. 
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2. On the Advanced Search left panel, select the Activity Group as 25% Design 
Package and click the Search button. 

 
The list of documents within the selected activity group will be displayed under the 
Uploaded Document(s) section. 

3. Select the checkbox(s) next to the Document Name(s) and click the Download 
button. 

 
The Users can see the downloads on their local drive. 
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5 Support  
The Support feature in the ProjectInfo application is designed to assist users with any 
challenges or questions they may encounter while using the system.  
Users can send an email to projectinfosupport@dot.state.ma.us. This email is prominently 
displayed on the footer of the Portal at all times. 
 
Upon sending the e-mail, a MassDOT Support group is alerted and will promptly respond to 
the User to resolve issues and continue work without significant delays.  

For example, when uploading a document in the Documents tab, a note will be displayed, 
providing a support email for further updates. By clicking on this email link, users can 
conveniently request updates or seek additional assistance. 

 

 

mailto:projectinfosupport@dot.state.ma.us
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6 Appendix   
6.1  ProjectInfo Definitions  
This section provides definitions for frequently used terms on the ProjectInfo platform.  
TERM  DEFINITION  
App  A shortened form of the term Application, an 

App is a collection of components, such as 
tabs, reports, and dashboards, that address a 
specific business need. Apps are assigned to 
Users.  

Assigned Projects  A Project that is assigned to a specific 
ProjectInfo staff user for review or action is 
considered as an Assigned Project.  
They can be located on the Assigned Projects 
list view.  

Unassigned Projects  Projects which are yet to be assigned to a 
Project Manager.  

Chatter  
  

A communication tool enabling a Project 
Team to collaborate.  

Chevron  The chevron on the Project page functions as 
a progress bar, illustrating all the stages of a 
project. The in-progress stage is colored Blue, 
and the current stage is highlighted green. 
Stages that are yet to start are in grey.  

Contact  
  

A Contact in ProjectInfo represents a Design 
Firm Admins and External Designer who have 
registered to conduct business with 
MassDOT. This is a representation of External 
Users that have been approved for 
ProjectInfo.  

Document(s) A term used for Project Correspondence, 
Design Submissions, Files, Plans, Reports, or 
any Design Deliverables. 

Home Page  The landing page which displays a list of work 
items, if any, assigned to the user. May 
display other tabs such as a Dashboard 
depending on the User Role.  

Portal  The MassDOT Project Information Portal 
offers restricted access as required for 
contracted staff to access and collaborate on 
features of a Project they are assigned to.  
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TERM  DEFINITION  
Project   A MassDOT Project is a transportation 

improvement initiative. Users can navigate to 
Project to find detailed information organized 
by relevant groupings.  

Report  A group of records that meet specific 
common criteria displayed in an organized 
series of rows and columns. Report data can 
be filtered, grouped, and displayed 
graphically as a chart.   

PINFO System 
Administrator  

Occasionally referred to as the Sys Admin, 
the ProjectInfo System Administrator is the 
individual who manages User credentials, 
assigns Users, and manages the back-end 
features and functions of the ProjectInfo 
system.  

Tab/Sub-Tab  
  
  

Organizes and segregates information within 
a page 

Work Items  Activities/Milestones/Tasks displayed on the 
Home Page for easy access  

Schedule  A single place to see all Project-related 
Information. Below terms are used to define 
various Project-related requirements and 
progress.  

  

6.2  Schedule Definitions 
This section provides definitions for frequently used terms on the Schedule.  

TERM DEFINITION 
Activity Record 
Page  

Tasks and Events record screen where 
essential info related to an Activity can be 
viewed.   

Baseline  A snapshot of a Project’s original, approved 
schedule before it starts. It can be used to 
compare the current schedule to the 
original plan to assess the performance of a 
Project over time.  

Critical Path  The Critical Path is the longest logical path 
through the network of activities  
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Dependency  A dependency is a link between two 
activities or between an activity and a 
milestone.  
There are 4 types of dependencies, Finish 
to start (FS), Finish to finish (FF), Start to 
start (SS), and Start to finish (SF).   
A dependency can be created within a 
single project Plan Gantt Board.   

Duration  The Duration is the amount of time to 
complete a work item from start to finish.  

Lag  A Lag is the delay of a successor work item 
to represent the time that must pass 
before a second activity can begin. Lag may 
be found in activities with all relationship 
types: finish-to-start, start-to-start, finish-
to-finish, and start-to-finish.  

Lead  The Lead is the acceleration of a successor 
activity (see also Lag, above). In other 
words, the second activity can begin (and 
be conducted in parallel) with the first 
activity. Lead is only found in activities with 
finish-to-start relationships i.e., A must 
finish before B can start.  

Milestone  Significant point in a Project schedule 
marking a key achievement or deliverable.  

Activity Owner  Individual responsible for any activity on 
the schedule.  

Percent Complete 
or % Done  

Indicates the amount of work completed 
on a work item as a percentage of the total 
amount of work required to complete that 
work item.   

 Schedule Activity  The sequence of activities required to 
complete a project. Project deliverables 
that are organized on a Schedule as Activity 
Groups, Activities and Milestones that 
represent the work that must be 
completed to advertise a project.  

Schedule (Gantt 
Chart)   

Gantt charts are commonly used in Project 
planning and scheduling to provide a clear, 
visual representation of the Project’s 
timeline, helping managers track progress, 
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identify delays, and allocate resources 
efficiently.  

Quick Actions  This is accessed through the schedule 
vertical ellipsis. A menu of frequently used 
actions.  

Resource 
Management  

The Resource Management views allow 
Resources to be effectively managed, so 
load balancing of Resources with Work 
Items is accommodated. Resource 
Management consists of the Resource 
Scheduling View and the Resource 
Utilization View, which both can be viewed 
at the same time through Split Screen 
Mode.  

Resource 
Scheduling View  

The Resource Scheduling View lists the 
Resources and which Work Items each 
resource has been assigned, along with the 
duration of each work item, represented by 
horizontal bars. Individual Work Items can 
be dragged and dropped between 
Resources to reassign Work from one 
Resource to another. The Resource 
Scheduling View can show Resources by 
Department Role Hierarchy or by Project 
and can be viewed in Split Screen mode 
with the Resource Utilization View to 
enable effective resource management.  

Risk Register  The Risk Register, or Risk Log, is a tool used 
to chronicle increased risk situations and 
risk responses as they arise.  

Sticker  A Sticker is a visual reference that the 
System automatically assigns to Work 
Items to draw attention to the 
item.  MassDOT may assign stickers to 
Activities. 

 

6.3  Table of Stickers  
These stickers are used as a visual reference that can be added to Boards and Cards to draw 
attention to the item.   
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Sticker Icon  Sticker Label/Hover text  

 
Pre 25%  

 
25% Design  

 
75% Design  

 
100% Design  

 
Critical Path  

 
Activity Risk Added  

 
Custom  

 
Automatic Update  

 
Not Applicable  

 
Major Milestone  

 
Manual Update  

 
PS&E  

 
Reporting  
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